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Best Practices 
Verification’s to Save Time Before submitting a Ticket


_____1. TxEIS is only supported by the following browsers:
Internet Explorer 11
Mozilla Firefox (Current Version) which we recommend using.
Safari 5.0 and later (Mac only)
Chrome (Current Version) 

 To verify the version, you are currently running, select ‘Help’, then About:
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Things that can cause your browser settings to change include:
· New Updates - TxEIS
· The district tech may make changes to district computers
· Browsers may have updates 

_____2. Verify the Browser Settings
	To locate the most current recommendations for your Browser Settings, click on your TxEIS app. Go to the bottom of the Sign On Page and select the ‘Click Browser Settings’ link. 
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_____3. Click on the word ‘here’.
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____4. The TxEIS Browser Settings Document. 
Scroll through the TxEIS Browser Settings document until you reach your browsers instruction. Each required setting is defined.




____5. Another setting to verify if you are having problems locating your Saved Downloads or Documents: 
Firefox: Open Menu (tools menu [image: ]) > Options > General > Downloads > click on the Radio button for ‘Always ask me where to save files’. 

Chrome: click on Customize and control Google Chrome (top right of the bar) [image: ] > Settings > Scroll to the bottom of page and click on ‘Show advanced settings’ > Scroll down to Downloads > check – ‘Ask where to save each file before downloading.’

____6. Close Browser to Save changes. 

Note #1: We have attached the current TxEIS Browser Settings as of 5/3/2017. The instructions for the Browser settings may change if the Browser makes any changes. If the attached setting does not match your Browser setting screen, then you will need to pull an updated TxEIS Browser Settings. See Step 2.  
[bookmark: _GoBack]
Note #2:  If your browser setting looks correct and you are still having trouble, contact Region 14 TxEIS Business Consultants for additional help.

[bookmark: TxEIS_Browser_Settings]


















TxEIS Browser Settings

Updated July 2016

The TxEIS Browser Settings document lists supported browsers and recommended browser settings which will allow you to utilize the TxEIS system at its fullest potential on any personal computer.


[bookmark: Supported_Browsers]Supported Browsers

Currently, Internet browsers supported by the TxEIS system include the following: For PC users:
· Internet Explorer (IE) 11

· Mozilla Firefox (current version)

· Chrome (current version) For Mac users:
· Apple Safari 5.0 and later (Mac only)

Note: Safari is the only browser that TxEIS supports on the Mac.

Please check your browser settings to ensure that your browser is set up to accommodate the browser setup requirements on the next page.


[bookmark: Screen_Resolution]Screen Resolution

The recommended screen resolution is 1280 x 1024.


[bookmark: Task_Bar_Setup]Task Bar Setup

Windows 7 allows pages to be opened directly from your task bar. With the TxEIS system, this feature will allow you to easily access different reports, pages, and applications, all from one centralized location. This feature is disabled by default but recommended for TxEIS.

1. Right-click the desktop, and select Personalize. The personalization dialog box is displayed.

2. Under See also (located near the bottom-left corner of the dialog box), click Taskbar and Start Menu. The Taskbar and Start Menu Properties dialog box is displayed.

3. On the Taskbar tab under Preview desktop with Aero Peek, select Use Aero Peek to preview the desktop.

4. Click OK.
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[bookmark: Browser_Setup]

Browser Setup

[bookmark: Internet_Explorer]Internet Explorer

From the Tools menu       ([image: ]), select Internet options. The Internet Options dialog box is displayed with the General tab as the default tab.

[bookmark: Set_Browsing_History_Options]Set Browsing History Options

On the General tab under Browsing history:

1. Click Settings.

2. Under Check for newer versions of stored pages, select Every time I visit the webpage. Click OK.

3. Select Delete browsing history on exit. Or, click Delete to manually delete all browsing history and to clear the cache.

· If Delete browsing history on exit is selected, all browsing history will be deleted, and the cache will be cleared each time you exit Internet Explorer.

· If Delete browsing history on exit is not selected, you can manually delete all browsing history and to clear the cache. Click Delete. Select all options except Preserve Favorites web site data, and then click Delete.

[bookmark: Display_Web_Pages_as_Tabs]Display Web Pages as Tabs

On the General tab under Tabs, click Tabs.

1. Under Tabbed Browsing, select all options except Open only the first home page when Internet Explorer starts.

2. Under When a new tab is opened, open, select The new tab page.

3. Under When a pop-up is encountered, select Always open pop-ups in a new tab.

4. Under Open links from other programs in, select A new tab in the current window.

5. Click OK.

[bookmark: Add_TxEIS_to_the_Trusted_Sites]Add TxEIS to the Trusted Sites

Click the Security tab.

1. Under Select a zone to view or change security settings, select Trusted sites [image: ].

2. Click Sites.

3. In the Add this website to the zone field, type the exact website address that you use to access TxEIS, and then click Add.

Note: If the website address begins with https, select Require server verification (https:) for all sites in this zone. If the website address does not begin with https,
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ensure that Require server verification (https:) for all sites in this zone is not selected.

4. Click Close.

[bookmark: Enable_Downloads]Enable Downloads

Click the Security tab.

1. Under Select a zone to view or change security settings, select Trusted sites [image: ].

2. Click Custom level.

3. Under Settings, scroll to the Downloads section.

4. Under File download, select Enable.

5. Click OK. If any settings were changed, a warning message is displayed confirming the changes. Click Yes to continue.

Enable Pop-up Windows

TxEIS uses pop-up windows to display reports and other information. The TxEIS website must be set up as an allowed site.

Click the Privacy tab.

1. Under Pop-up Blocker, select Turn on Pop-Up Blocker.

2. Click Settings.

· Under Exceptions in the Address of website to allow field, type the exact website address that you use to access TxEIS.

· Click Add. The website is displayed under Allowed sites.

3. Click Close.

[bookmark: Reset_Zoom_Level_for_New_Windows_and_Tab]Reset Zoom Level for New Windows and Tabs

The zoom level for Internet Explorer can be changed at any time from View > Zoom or by using the mouse. However, TxEIS performs best when the zoom level is set to 100%; otherwise, some features may not display correctly.

Click the Advanced tab.

1. Under Accessibility, select Reset zoom level for new windows and tabs.

2. Click OK.
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[bookmark: Mozilla_Firefox]Mozilla Firefox

From the Firefox tools menu       ([image: ]), select Options. The Options dialog box is displayed with the General tab as the default tab.

Enable Cookies

From the Options dialog box, click the Privacy icon.

1. Under History in the Firefox will field, select Use custom settings for history.

2. Select Accept cookies from sites.

This option should be selected by default. If you do not want to accept cookies from all sites, continue to the next step.

3. Next to Accept cookies from sites, click Exceptions. The Exceptions - Cookies dialog box is displayed.

· Under Address of website, type the exact website address that you use to access TxEIS.

· Click Allow. The website is displayed under Site, and the Status is set to Allow.

· Click Close.

[bookmark: Clear_History_When_Firefox_Closes]Clear History When Firefox Closes

From the Options dialog box, click the Privacy icon.

1. Under History in the Firefox will field, select Use custom settings for history. (This should have been selected in the previous step.)

2. Select Clear history when Firefox closes.

3. Click Settings…

4. Ensure the following fields are selected:

· Active Logins

· Form & Search History

· Cookies

· Cache

· Click OK.

Enable Pop-up Windows

TxEIS uses pop-up windows to display reports and other information. The TxEIS website must be set up as an allowed site.

From the Options dialog box, click the Content icon.

1. Select Block pop-up windows.
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2. Next to Block pop-up windows, click Exceptions. The Allowed Sites - Pop-ups dialog box is displayed.

· Under Address of website, type the exact website address that you use to access TxEIS.

· Click Allow. The website is displayed under Site, and the Status is set to Allow.

· Click Close.

Enable JavaScript

JavaScript must be enabled for the TxEIS website for proper operation of TxEIS.

In Firefox 22 and earlier:

From the Options dialog box, click the Content icon.

1. Ensure that Enable JavaScript is selected.

2. Click OK.

In Firefox 23 and later:

JavaScript is enabled by default in Firefox 23 and later. To make sure it is enabled follow these instructions.

1. In the address bar, delete the existing website address and type “about:config”. Press ENTER.

2. A warning message is displayed. Click I’ll be careful, I promise! The Mozilla Firefox preferences are displayed.

3. In the Search field, type “javascript.enabled”. Press ENTER. The result javascript.enabled is displayed.

4. The Value column should be true. If it is not, right-click javascript.enabled and select
Toggle to enable JavaScript.

5. Close Firefox to save changes. You may need to restart Firefox for the changes to take effect.

[bookmark: Upload_Data_When_a_New_Page_is_Loaded]Upload Data When a New Page is Loaded

1. In the address bar, delete the existing website address and type “about:config”. Press ENTER.

2. A warning message is displayed. Click I’ll be careful, I promise! The Mozilla Firefox preferences are displayed.

3. In the Search field, type “cache”. Press ENTER.

4. Double-click this setting in the list: browser.cache.check_doc_frequency. The Enter integer value dialog box is displayed.

5. The default value is 3. Change the value to 1. Click OK.
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6. Confirm the browser.cache.check_doc_frequency value changed from 3 to 1 in the
Value column.

7. Close Mozilla Firefox to save the changes.


Prevent Timeouts (Firefox 30 and later)

1. In the address bar, delete the existing website address and type “about:config”. Press ENTER.

2. A warning message is displayed. Click I’ll be careful, I promise! The Mozilla Firefox preferences are displayed.

3. In the Search field, type “response”. Press ENTER.

4. Double-click this setting in the list: network.http.response.timeout. The Enter integer value dialog box is displayed.

5. Replace the existing value with 3600 (or greater). Note that this is the number of seconds. 3600 seconds equals one hour. Click OK.

6. Confirm the network.http.response.timeout value changed accordingly in the Value
column.

7. Close Mozilla Firefox to save the changes.
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[bookmark: Prevent_Timeouts_(Firefox_30_and_later)]
[bookmark: Safari_(for_Mac)]Safari (for Mac)

From the menu bar, select Safari, and then select Preferences.

[bookmark: Enable_Cookies]Enable Cookies

1. From the Preferences dialog box, select Privacy.

2. Next to Cookies and website data, select Allow from websites I visit.

Enable Pop-up Windows

TxEIS uses pop-up windows to display reports and other information. By default, Safari blocks pop-up windows. The pop-up blocker must be disabled for the TxEIS website for proper operation of TxEIS.

1. From the Preferences dialog box, select Privacy.

2. Next to Web content, ensure that Block Pop-Up Windows is not selected.

[bookmark: Enable_JavaScript]Enable JavaScript

JavaScript must be enabled for the TxEIS website for proper operation of TxEIS.

1. From the Preferences dialog box, select Security.

2. Next to Web content, ensure that Enable JavaScript is selected.

[bookmark: Disable_AutoFill]Disable AutoFill

AutoFill may cause some fields within TxEIS applications to fill automatically.

1. From the Preferences dialog box, select AutoFill.

2. Next to AutoFill web forms, clear all four check boxes.
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[bookmark: Google_Chrome]Google Chrome

To ensure optimal security when using Chrome, you must turn off some default settings using the following steps.

From the Chrome menu      ([image: ]), select Settings. From the Settings page, click Show advanced settings.

[bookmark: Disable_Cookies]Disable Cookies

1. Under Privacy, click Content settings…

2. Under Cookies, ensure that Keep local data only until you quit your browser is selected.

For more information, visit https://support.google.com/chrome/answer/95421?hl=en.

[bookmark: Enable_Pop-up_Windows]Enable Pop-up Windows

TxEIS uses pop-up windows to display reports and other information. The TxEIS website must be set up as an allowed site.

1.  Under Privacy, click Content settings…

2.  Under Pop-ups, click Manage exceptions…

3. Under Hostname pattern, type the exact website address that you use to access TxEIS. Under Behavior make sure Allow is selected.

4. Click Done.

[bookmark: JavaScript_(Enabled_by_Default)]JavaScript (Enabled by Default)

JavaScript must be enabled for the TxEIS website for proper operation of TxEIS.

1. Under Privacy, click Content settings…

2. Under JavaScript, select Allow all sites to run JavaScript (recommended). Or, if you do not want to allow all sites to run JavaScript, click Manage exceptions…

In the JavaScript exceptions dialog box under Hostname pattern type the exact website address that you use to access TxEIS. Under Behavior select Allow.

3. Click Done.

[bookmark: Enable_AutoFill]Enable AutoFill

AutoFill may cause some fields within TxEIS applications to fill automatically.

Under Passwords and forms, clear Enable Autofill to fill out web forms in a single click.
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TxEIS Browser Check

Javascript, Cookies and PopUps are properly
enabled for this browser.

Please click here to see a complete list of
required browser settings for TXEIS.
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Login

User Name:

EIS' Password:

County/District [217301
Number:

3.0.0000
0183

HOT in Txel

IMPORTAN
This is a security-protected system. Unauthorized use is prohibited. Only authorized personnel are allowed to use
the system for authorized purposes. By logging on, you acknowledge that you are an authorized user.

Browser Requirements:
* Internet Explorer 11

« Mozila (Current Version)

© Safari 5.0 and later (Mac only)
« Chrome (Current version)




